
♦ Maple™ 9 is a powerful problem-solving environment for:
1. Numerical calculations.
2. Symbolic computations. 
3. Visualizing math expressions and data.
4. Single stepping through popular mathematical concepts.
5. Programming custom math functions. 
6. Communicating with external applications and servers.

♦ To view the Introduction to Maple 9 :
♦ Select Introduction from the Help menu

♦ For information about new and improved features in Maple 9:
♦ Select What’s New from the Help menu

♦ Access online help by:
1. Selecting Topic Index or Search from the Help menu or, for general 

information, selecting Using Help.
2. Selecting the Help icon in the toolbar to open the help system.

3. Entering ?topic or ?topic/subtopic at the Maple prompt (e.g., ?int or 
?LinearAlgebra/Transpose).

♦ In Maple 9, data is entered and calculations are performed in a worksheet
(see ?worksheet). In a worksheet you can:

1. Click and Compute with your mouse to do math.
2. Use the Maple 9 versatile command language.

Command Language
The Maple command language provides efficient access to all 3,500+ Maple functions.
For example, a definite integral is entered at the Maple command prompt (>) as:

[> int(sin(x)*cos(x),x=a..b);

Maple Symbols
Symbol Description Example

; Statement terminator that displays output [> x:=3;
[> x^2;

: Statement terminator that suppresses output [> x:=3:
[> x^2:

, Separator used in expression sequences [> plot(x^2,x=-1..1);

:= Assignment operator [> eq1:=5*x^2+7:
[> solve(eq1,x);

= <> Equality and inequality operators [> solve(x+1/x>0,x);
< > <=
>=

|| Concatenation operator (see also ?cat) [> i:=5;
[> a||i;

( ) Enclose function parameters or clarify precedence [> fn(x);
[> x+y/p;
[> (x+y)/p;

[ ] List delimiters (a list is ordered) or indicate [> L:=<1,0,0>; L[2];
subtopics in packages [> plots[arrow](L);

< > In conjunction with |, used to construct rtable [> A:=<<1,2>|<3,4>>;
Matrices and Vectors

" " String delimiters [> x:="A string"; 

` ` Name delimiters (also called backquotes) [> `A name` := 1;
[> `A name`;

' ' Prevent evaluation (clear variable definitions) [> x:=3; x;
[> x:='x'; x;

% Previous, 2nd-last, and 3rd-last results [> x:=3:
%% (also called ditto perators) [> y:=2:
%%% [> %; %%%;

# Insert a comment [> # My comment !!

\ Continuation character or indicate control characters [> 3.1415926535\
89793;

[> printf(`%d %2d \n`, 
2, 2^2);

-> Arrow operator [> f:=s -> s^2; f(3);

@ Composition operators [> (sin@cos)(x);
@@ [> (sin@@2)(x);

$ Sequence operator (see also ?seq) [> diff(x^3, x$2);
[> $1..10;

Maple 9 Information
For more information on Maple 9, visit www.maplesoft.com.

For applications describing several new features and benefits in Maple 9,
visit www.mapleapps.com.

To learn what Maple can do for you, visit www.mapleapps.com/App_Center_Tour/.

Maple Resources
The Maple Application Center™ (www.mapleapps.com) contains over 1,500 applications
to view or download. Topics include calculus, linear algebra, physics, and civil engineering.

The Maple Student Center™ (www.maple4students.com) provides educational material
and Maple resources to assist students.  Several tutorials include complete course 
curricula for calculus, differential equations, and linear algebra.  

Frequently Asked Questions (www.maplesoft.com/support/Faqs/) provides information
on popular topic areas.

Click and Compute

Palettes Four palettes allow you to easily enter symbols, expressions, Vectors, 
and Matrices.  From the View menu, select Palette.

Context-Sensitive Right-click the Maple output (command-click in Macintosh®) to
Menus display related operations. For example, right-clicking a polynomial 

displays a menu to integrate, differentiate, simplify, plot, and more. 
Relevant operations are displayed based on the output selected. 
Context-sensitive menus are available for expressions, text regions, 
plot regions, and spreadsheets.

Smart Plots Right-click appropriate output expressions (command-click in 
Macintosh) to generate its plot by selecting Plots then 2-D or 3-D Plot 
from the menu presented. By selecting an expression output or a curve
from the Smart Plot region, expressions and curves can be dragged to 
the plot region.

Common Mathematical Functions & Constants

Mathematical Maple Functions
Functions and Constants and Constants Example

sum, difference, product, +, -, *, [> q:=x-(1/2)^3;
quotient, power /, ^

square root, sqrt [> sqrt(2);
nth root surd [> surd(2,3);

absolute value, |x| abs [> abs(2*x-3);

binomial coefficient binomial [> binomial(4,2);

factorial, n! ! [> 12!;

exponential, ex exp [> exp(x);

natural logarithm ln [> ln(2);
logarithm base 10 log10 [> log10(2);
logarithm base b log[b] [> log[2](3);

trigonometric functions sin, cos, tan, [> sin(Pi/6);
(in radians) csc, sec, cot,

inverse trig functions, arcsin, arccos, arctan,  [> arcsin(1/2);
arcsec, arccsc, arccot

hyperbolic functions sinh, cosh, tanh,  [> sinh(3.1+2*I);
csch, sech, coth

inverse hyperbolic functions arcsinh, arccosh, arctanh, [> arcsinh(1.2 + 3.4*I);
arcsech, arccsch,  arccoth

Bessel functions BesselI, BesselJ, [> evalf(BesselJ(0,2));
BesselK, BesselY 

computation modulo m mod, modp, mods [> 12 mod 7;
[> modp(12,7);

logical operators and, or, not, xor, [> if a>0 and b>0 then 
implies, logical print("a>0, b>0"); 

end if;

π Pi  [> evalf(Pi); 
e exp(1) [> evalf(exp(1));
i I [> (10+5*I)*(3+I);
∞ infinity [> int(1/x^2, x=1..infinity);
Catalan’s number Catalan [> evalf(Catalan);
Euler’s constant gamma [> evalf(gamma);
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Examples Using Maple’s Command Language
1.  Solving Equations

The Maple solve command solves equations and systems of equations.  Other solvers include: dsolve,
fsolve, isolve, msolve, rsolve, and LinearAlgebra[LinearSolve].

[> ?solve [> solve({y=x^2,y=x+5},{x,y});
[> ?allvalues [> allvalues(%);

2.  2-D and 3-D Plotting

The Maple plots[interactive] routine invokes an interface to several plotting routines and plot options.
Alternatively, use the command-line syntax for plotting.  Other plotting routines include plots[animate],
and plots[display].

[> ?plots [> plots[interactive](sin(x));
[> ?plot,options [> plot(sin(x)*cos(x), x=0..Pi);
[> ?plot3d, options [> plot3d(sin(x)*y, x=0..Pi, y=0..Pi);

3.  Integration and Differentiation

The Maple int command is used for definite and indefinite integration.  For numerical integration use 
Int (inert form of int) with evalf (floating-point approximation).  The Maple diff command returns the
derivative with respect to the indicated variable(s).

[> ?int [> int(sin(x),x=0..Pi);
[> ?int,numerical [> int(x/(x^3-1), x);
[> ?diff [> evalf(Int(sin(x)*x, x=0..1));

[> diff(sin(x),x);

4.  Solving Differential Equations

Maple can solve many ODEs, including initial-value and boundary-value problems, and PDEs.

[> ?dsolve [> DE:=D(D(y))(x)+5*D(y)(x)+6*y(x);
[> ?DEtools [> InitCon:=y(0)=0, D(y)(0)=1;
[> ?pdsolve [> dsolve({DE,InitCon},{y(x)});

5.  Matrices and Vectors

The LinearAlgebra and VectorCalculus packages provide many commands for working with 
Matrices and Vectors.

[> ?LinearAlgebra [> M:=Matrix([[5, x^2],[3/2, x]]);
[> LinearAlgebra:-Determinant(M);

6.  Writing a Procedure

The Maple procedural programming language can be used for writing simple and complex procedures.

[> ?proc [> for i from 1 to 5 do i^2;  end do;   
[> ?for

Common Maple Commands
Command Description Example

Mathematics

alias Define an abbreviation [> alias(J=BesselJ);
[> J(0,-x);

allvalues Find values of RootOf expression [> allvalues(2*RootOf(_Z^3-
1) - 1);

assume Assign properties to a variable [> assume(a>0);

convert Convert an expression to [> convert(9,binary);
a different form [> convert(tan(x),sincos); 

eval Evaluate numerically [> poly:=x^3+3*x+2; 
[> eval(poly,x=1);

evalf Find the floating-point approximation [> evalf[500](Pi);

Im, Re Find the imaginary or real part [> Re(Pi+I*exp(1));

numer, denom Find the numerator or denominator [> numer(1/x + 1/(x+1));

RootOf Representation for roots of equations [> RootOf(a*x+b, x);

simplify Apply simplification rules [> simplify(4^(1/2)+3);

expand Expand an expression [> expand((x+1)*(x+2));

value Evaluate an inert function [> F:=Int(sin(x),x);
[> value(F);

with Make package functions available [> with(plots);

Expressions
anames, unames Query assigned and [> a:=b^2: 

unassigned names [> anames();

args, nargs Return arguments and number [> for i from 1 to nargs do
of arguments for a procedure

map Apply procedure to operands [> map(x->x^2,x+y);

op, nops Return operands and [> u:=[1,4,9]; op(2,u);
number of operands [> nops(u);

rhs, lhs Return right- or left-hand side [> eqn:=y=a*x^2+b;
[> rhs(eqn);

seq Create a sequence  [> seq(sin(Pi*i/6), i=1..6);

type, hastype Type-checking functions [> type(Pi,finite);

Expressions

restart Clear Maple memory [> restart; 

Interactive Tutors
1.  Precalculus
Study lines, polynomials, linear inequalities, functions and more in this set of interactive tutorials for Precalculus.

[> with(Student[Precalculus]);

2.  Calculus I
Step through differentiation, integration and limit problems or graphically display Newton’s Method, the 
volume of revolution, approximate integration, and more within this set of easy-to-use graphical interfaces.

[> with(Student[Calculus1]);

3.  Linear Algebra
Step through Gaussian elimination or Gauss-Jordan reduction methods, and more in interactive tutors.
Several visualization routines display the cross product, linear systems, linear transformation, and more. 

[> with(Student[LinearAlgebra]);

Maple Packages
Maple packages are collections of related functions. Below is a sampling of the 84 Maple packages
available to users. For a full listing, see ?index/package.  Package commands can be accessed by
either their short form or their long form. 

Form Example

Short [> with(LinearAlgebra):
[> Trace(Matrix([[1,2],[a,b]]));

Long [> LinearAlgebra[Trace](Matrix([[1,2],[a,b]]));

Package Name Description

CodeGeneration Translate Maple code to C, FORTRAN, Java™, MATLAB®, and Visual Basic®

combinat Combinatorial functions

combstruct Combinatorial structures

CurveFitting Functions that support curve-fitting

DEtools Tools for differential equations 

GaussInt Gaussian integers

geometry Euclidean geometry

Groebner Groebner bases 

inttrans Integral transforms

LinearAlgebra Over 100 functions for constructing, solving, and programming
topics in linear algebra

LinearFunctionalSystems Construct solutions of linear functional systems of equations

ListTools Tools for manipulating lists

Maplets Create graphical interfaces to Maple functions

MathML Import and export Maple expressions as MathML

Matlab MATLAB link

numapprox Numerical approximation

PDEtools Partial differentiation tools

plots Graphics package 

plottools Basic graphical objects

PolynomialTools Functions to perform basic manipulations of polynomials

RandomTools Tools for working with random objects

RationalNormalForms Construct minimal representation and decomposition of hypergeometric terms

RealDomain Provides a real number context

ScientificConstants Values of over 13,000 constants commonly used in chemistry and physics

ScientificErrorAnalysis Construct quantities with errors and propagate errors through calculations

Spread Programmatic access to spreadsheet data

stats Common statistical routines

Student[Calculus1] Step through differentiation, integration, and limit problems or visualize
concepts presented in a first year calculus course

Student[Precalculus] Tutorials to study lines, polynomials, linear inequalities, and more

Student[LinearAlgebra] Step through Gaussian elimination and Gauss-Jordan reduction methods or 
visualize concepts presented in a linear algebra course

Sumtools Indefinite and definite sums

Units Convert among 750+ units

VectorCalculus Perform multivariate and vector calculus operations on objects
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